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Congratulations on your purchase of PrintMusic 2011 for Windows! 
 
IMPORTANT: Read this document before you begin working with PrintMusic 2011 and print a copy of it to keep with 
your PrintMusic information.  
 
This file contains important information about PrintMusic 2011 not included in the User Manual as well as 
information about converting older files into the new version's format. Please note that PrintMusic 2011 files cannot 
be opened directly in previous versions of PrintMusic. However, PrintMusic does support export and import of 
MusicXML files, which are compatable with recent versions of PrintMusic. See Running older versions of PrintMusic 
and MusicXML below for details. 
 
This document is organized by each version's changes; those of you already familiar with earlier versions may wish to 
read only the new information. The Read Me contains the following sections: 
 

Running PrintMusic 2011 
New features in PrintMusic 2011 

 
You may also visit our web site, www.finalemusic.com, for updated information about PrintMusic and information on 
new releases.  
 

Running PrintMusic 2011 
 
System Requirements 
PrintMusic 2011 for Windows requires Windows XP/Vista/7 (64-bit compatible). A minimum of 512MB RAM, and 
350MB of free hard drive space. CD-ROM drive. 800x600 minimum monitor resolution. 
 
Installing PrintMusic 2011 
If any previous version of PrintMusic has been installed on the machine, PrintMusic 2011 recommends that you restart 
your computer and log on as System Administrator before installing. This will prevent erroneous font warnings. 
 
We always recommend that you install PrintMusic, and any other software, when logged in as System Administrator. 
 
If you encounter problems during installation, we recommend that you do the following: 
 
1. Turn off any programs running in the background. Virus detectors can often prevent Finale from installing  
 necessary files and updating the registry. Rest assured, your Finale CD does not contain any viruses. 
2. Press Ctrl-Alt-Delete, then click on Task Manager and then the the Process tab. In the Processes Tab, click 
 on "User Name" to sort the running programs by user ID name. This lists every process that is running on  
 the system. 
3. Under the User Name column, look at all of the processes ("Image Name") with your account name. Click  
 on each one, and then click "End Process" and select OK.  Do this for every process assigned to your name 
 except “taskmgr.exe”, “explorer.exe”, and “System Idle Process.” 
4. Close the Task Manager. 
5. Check your system tray (lower-right corner of the screen) to see if any programs are running. Right-click  
 each of these and choose Close - especially antivirus software, which does interfere with programs properly 
 installing. 
 
Authorizing PrintMusic 2011 
Windows Vista Users, in order to authorize you must open PrintMusic as the administrator. Right-click the PrintMusic 



2011 icon and choose “Run as Administrator” to do this. 
 
The first time you launch PrintMusic, you will be prompted to authorize. To authorize a single copy of PrintMusic, 
click Authorize Now! to open the Authorization Wizard (or, from the Help Menu, choose Authorize PrintMusic). 
Then follow the instructions to authorize your copy of PrintMusic via the Internet, phone, or mail. If you choose not to 
authorize, you will be prompted to do so each time you launch PrintMusic. If you do not register within thirty days, 
printing and saving are disabled until you choose to authorize. 
 
Note that the User/Authorization Codes are computer specific, and will only work on the given computer installation. 
Make sure that the Authorization Code is typed in using capital letters, and also verify that the correct serial number 
has been entered. Your copy of PrintMusic can be authorized on only one computer at a time, but with an Internet 
connection, authorization can be moved from one computer to another at will. Simply choose Deauthorize PrintMusic 
from the Help Menu to open up a free slot. Your copy of PrintMusic can now be authorized on a different computer.  
 
If you make a change to the computer (such as replacing the hard drive or motherboard, or installing a new operating 
system), then you will need to re-authorize the installation. If you have already installed and authorized, you will need 
to contact Customer Service directly by phone, FAX or standard mail with your serial number and the location ID for 
the specific installation in question, and one of our representatives can clear the previous authorization from your 
account. If the software is not "reminding" you to authorize when you run the program, then the 
registration/authorization has been successfully completed. 
 
Starting PrintMusic 2011 - DLLs 
Most applications (including MakeMusic products) require a set of files, the Microsoft redistributables, in order to 
work successfully on your system. These redistributable files are normally already present on most systems and are 
not generally included in application setup/install scripts - doing so would add about 1.5 MB to the size of the package, 
and cause a longer installation process. More importantly, as these files are constantly updated by Microsoft and are 
operating-system specific, including these files in an application installer could result in incorrect files being added in 
your system and subsequent problems. 
  
In rare cases these files may be missing or out of date on your system. In this case an error will be reported when you 
start the program. Here are some examples of the errors that could be reported:  
If the files are missing...  
'The dynamic link library MSVCP60.DLL could not be found in the specified path...' 
or  
'The dynamic link library MSVCRT.DLL could not be found in the specified path...' 
If the files are out of date...  
'The OCXTS.EXE file is linked to missing export MFC42.DLL:6880.' 
 
If you see one of these messages, visit www.microsoft.com for more information regarding these files and how to 
restore them. 
 
User Manual 
For full documentation on how to run PrintMusic 2011, see the User Manual. To access the User Manual, from the 
Help menu, choose User Manual. 
 
Repertoire 
To view PrintMusic’s worksheets and repertoire, from the File menu, choose Open, and double-click the 
"Repertoire" shortcut. 
 
Interface Changes 
To see a list of all interface changes, see “PrintMusic 2011 Interface Changes” in the PrintMusic 2011 User Manual. 
 
Linked Parts Relationship in PrintMusic 
PrintMusic 2011 does not include the Linked Parts feature available in Finale 2011. PrintMusic can, however, open 
any file created in Finale 2011 including those containing linked parts. When doing so, the linked parts are invisible 
and changes to broken (unlinked items) in parts are unavailable completely. Changes to the score that apply to parts, 



such as changing pitches or moving linked expressions, do apply to parts as they would if you were editing the score in 
Finale 2011. When the PrintMusic file is saved and reopened in Finale 2011, the linked parts can be viewed and edited 
as usual.  
 
Sharing Finale Documents Online with Finale Reader 
Finale Reader provides a free, reliable, easy way to view and playback PrintMusic documents downloaded from the 
Internet. To open a PrintMusic file available at Finale Showcase, or another online resource, viewers now need to 
simply download the file to their local machine and then open it in Finale Reader. This means all PrintMusic 2011 files 
posted on the Internet will be available for viewing on all machines. Finale Reader is available for download free of 
charge at www.finalemusic.com/reader.  
 
Contacting Customer Support 
For customer support, visit http://www.finalemusic.com/support. 
 
Converting PrintMusic 2010 (and earlier) documents into PrintMusic 2011 documents 
PrintMusic 2011 will open and convert older versions' documents, giving them the default title "UNTITLED.MUS." 
We recommend saving a newly converted document with a different name than the original file, keeping the older 
unconverted file as a backup. If you do want to save the file using the same name, choose Save As from the File menu. 
PrintMusic displays the original file name, so you can click OK to rewrite over the old file. 
 
Running older versions of PrintMusic and MusicXML 
PrintMusic 2010 (and earlier versions) for Windows or Macintosh cannot open any PrintMusic 2011 file, except 
Standard MIDI Files. To share PrintMusic 2011 files with PrintMusic 2010, you can export the file to MusicXML 
format (under PrintMusic 2011’s File Menu) and then Import the MusicXML file in PrintMusic 2010. 
 
Updating PrintMusic preferences settings 
PrintMusic 2011 can convert your old PrintMusic.INI settings. If you want to use your old settings, copy the 
PrintMusic.INI file from your old PrintMusic directory into the new PrintMusic 2011 directory. 
 
 

New Features in PrintMusic 2011 
 

• Improved Lyric Entry. Lyrics are more easily entered and instantly appear exactly as they’ll print out. 
• Music containing Lyrics Looks Better – Automatically.  Lyrics space themselves and the notes they’re 

attached to automatically so that you can have engraver-level quality without manual editing.  
• Automatic Word Extensions. Word extensions automatically draw to the next rest and also wrap to the next 

system. If the music expands or contracts, the extensions stretch or shrink to fit. 
• Ignore Lyric Punctuation. Punctuation, at the beginning or end of a lyric, can now be ignored for better 

alignment and centering of different verses.  
• Automatic Lyric Numbering. Finale can now automatically add verse numbers to your lyrics. Add a new 

verse? It’s numbered too!  
• Hard Spaces and Hyphens. "Hard" spaces and hyphens are used to add spaces and hyphens within lyric 

syllables without separating them into multiple syllables. Add them easily using new menu options.  
• Umlauts and other Characters. If you don't recall the associated keystroke for a needed umlaut, grave 

accent or other diacritical character, you can now simply select those items by sight.  
• Moving Staves. It’s now incredibly easy to move staves, in individual systems, or throughout the score. 

Want to increase the distance between staves? Click and drag. Your music updates automatically as you drag 
and you receive on-screen feedback about the distance between the staves and what staves will be impacted.  

• Reordering Staves. Want to reorder staves and/or groups? Now it's easily done instantly in one place.  
• Finale Percussion Font. Many publishers use icons to represent standard percussion instruments in their 

scores. This font contains the most complete collection of percussion characters available. Also included are 
handbell symbols and many unique characters including castanets, sine waves, scribbles, and more.  

• Finale Mallets Font. The Finale Mallets font includes icons to represent any variety of mallet usages, 
including the ability to create cross-mallet symbol. For example, you could use two of the zero-width mallet 
characters to indicate the performer should use a yarn mallet in the left hand and a hard mallet in the right 



hand.  
• Music Educator Resources including worksheets, flash cards, and repertoire are included with your 

PrintMusic installation. 
o Worksheets. PrintMusic 2011 includes more than 30 Music Education Worksheets. Designed for 

K-12 students, these educator-approved worksheets help teach basic elements of music and can be 
printed out for students to complete. Subjects covered include clefs, scales, key signatures, circle of 
fifths, and more. 

o Flash Cards. Dozens of Music Education Flashcards are included, designed to print double-sided 
(with the answers on the back) for classroom use or self-quizzing. Topics include keys, note names, 
and musical symbols. 

o Repertoire. Ten titles of Classroom Repertoire are provided, including Bach Inventions, traditional 
and holiday titles, and more. 

o Manuscript Paper. Two Music Manuscript documents are included as well. Print either the grand 
staff or generic example to have music manuscript handy for note taking or inspiration even when 
you’re away from the computer. 

• Handbells Used Chart. PrintMusic can automatically create a chart at the top of your handbell music that 
lists every bell used.  

• Improved Pickup Measures. Finale now automatically fills pickup measures with the appropriate rest 
duration.  

• Updated Display Colors. Finale PrintMusic's screen display has been improved with attractive score colors 
for layers, dynamics, and other colored score elements. 

• Folder Reorganization. To accommodate multiple users on the same machine and to prevent permissions 
issues, PrintMusic 2011 now installs application-specific files to different locations on your hard drive. Refer 
to PrintMusic Installation Details to identify the new locations for PrintMusic's various components. 


